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Introduction
SubtitleCreator v2.2 allows you to convert ASCII based text files in SubRip’s SRT or

MicroDVD’s SUB format to the binary SUP format expected by DVD authoring tools such

as MuxMan or IfoEdit or to the binary VobSub format (*.sub/*.idx) expected by the most

recent Stand Alone Players and by some software DVD players (like Media Player Classic or

KMPlayer). As such, you are able to create and add your own subtitles to a DVD or

vizualize your subtitles whatever the fonts they use on your SAP. You can also manipulate

existing subtitles, for example to shift them or to change their colors. Additionally, if you

don’t own the copyright of the DVD, you can overlay subtitles on top of your DVD. Finally,

it also included a DVD Authoring Wizard function, which is especially useful for beginners

and lazy people like me to add a new subtitle to a previously copied DVD (e.g. with

DVDShrink). It combines the power of PgcDemux, MuxMan and VobBlanker to add

subtitles in one go, thereby even allowing you to retain the original DVD menu.

GUI language
SubtitleCreator supports several GUI languages: English, Dutch, French and Finnish.

Normally it should automatically default to the same language as the installed Windows

language. If you want to change SubtitleCreator’s GUI language, go to Settings � Specify

GUI language (requires restart) and choose the language you want SubtitleCreator to use.

Then click on the OK button to close SubtitleCreator. Then restart it and it will show up in

the language you have chosen.

Overview of main features
To give you a brief overview of its features, consider the following list:

• Convert SubRib (*.srt) or MicroDVD (*.sub) files to IfoEdit (*.sup) or VobSub

(*.sub/*.idx) files.

• When converting to the *.sup format, SubtitleCreator can also generate a file holding the

used palette. This file can use one of the following format: *.ifo, *.mxp (muxman project

format) or *.clb (pgcedit format).

• Load (thanks to the SubRip sources) the corresponding IFO file to determine whether we

are dealing with a PAL or NTSC movie, and to read the color palette which is used by

the original subtitles: by default, a white text, a black outline and a silver anti-alias color

on a transparent gray background are selected.

• Uses the line breaks you defined in the *.srt source, such that dialogs stay on different

lines. However, the maximum number is defined by you, and if it doesn’t fit the window,

the subtitles are joined and, if necessary, shrunken. If selected in the Settings menu

(default is true), the subtitles which are too long will be highlighted in light blue. You

can also warn when the subtitle’s duration is too short (default is off).

• You can use <i>italics</i>, <b>bold</b>, or <u>underlined</u> subtitles, <L>, <l> and

<s> for LARGE, large, and small text, and specify a subtitle’s exact position (SubRip

format)

• You can use <k>karaoke color</k> to use an extra color of the palette in your subtitles.

This is a karaoke mode. You can chose the color for the karaoke texts in the main

window of SubtitleCreator.

• Preview and position your subtitles (using a screenshot as background or the original

DVD). You can even preview you DVD with the subtitles being overlaid on top of it as if

it was the final DVD.



• Deselect subtitles that you don’t want

• Automatically deselects credit lines (with @, or http)

• Choose the font that you like to use

• Use profiles for default font and subtitle window position settings

• You can join several subtitle files, e.g. if the original subtitle consisted of two parts

• Synchronize the subtitles using time shifting; frame rate conversion; or, my preferred

option, using the original subtitle *.sup or .sub/.idx: you can select matching subtitles in

the new and original subtitle and match them. Save the synchronized subtitle file

• Stretch subtitles in horizontal and vertical direction

• Specify how many lines you wish to use for the subtitle

• Specify whether you want SC to automatically wrap lines

• Specify whether you want SC to generate bitmaps of the subtitles for you

• Specify whether you want SC to remove double spaces and other types of annoyances

• When opening a MicroDVD’s SUB file, special formatting commands are automatically

recognized, like {Y:i}, {Y:b} and {Y:bi}

• You can define your own shortcuts in the configuration file, e.g. <s M> gives you the

music symbol

• You can search for a subtitle string.

• SUP or VobSub manipulation tool, which allows you to remap the colors of a binary

subtitle SUP or VobSub file, or to shift it vertically

• SUP or VobSub to SRT translation tool, providing you with a simple editor to translate

your DVD from scratch.

• Most Recently Used File list, and the option to automatically open the last used file

• DVD Authoring Wizard which, together with two other great freeware tools, PgcDemux,

MuxMan and VobBlanker can simplify the process of adding a subtitle to a new movie

(You can even keep the menu).

• Special command buttons in the main window: set the font for a single subtitle, increase

and decrease fonts

Well, that’s about it before I show you some screenshots. If you have some suggestions, or if

you found some bugs, please mail them to me via subtitle forum at http://forum.doom9.org

or send me a private message as Paddington.

Installation
Very simple – just run the installer, which will install the SCFilter for you as well. It requires

that you have installed the .NET framework 2.0 and DirectX plus a DVD decoder (if you

want to preview subtitles on top of your DVD, we recommend that you install PowerDVD 6

first).

If you intend to use the DVD Authoring Wizard, which I can definitely recommend, please

also install PgcDemux, MuxMan and VobBlanker (default location in C:\Program

Files\DVD).



Main Window

About the menu:

• The File menu allows you to open the DVD’s IFO file (in order to read the color palette

and PAL/NTSC settings), the subtitle file (SRT or SUB format), and save them as binary

SUP or VobSub (or SRT) file. Additionally, you can check to join multiple subtitles in

case the originals are split, or load another background.

Tip: Press CTRL-X, and enter eXpress mode, which quickly lets you load the subtitle

file, the IFO file, and the SUP or VobSub file for synchronization.

• The Format menu controls the display of the subtitles, and you can load a predefined

profile (as specified in the Profiles.xml configuration file), which controls fonts,

outline width, wrapping, etc. You can also overrule the formatting settings, change the

vertical alignment of the subtitle in the subtitle window (yellow rectangle). Additionally,

you can select a different outline and anti-aliasing rendering method (uncheck

“Characters unconnected”), which might be useful for Persian fonts.

• The Settings menu controls PAL/NTSC settings, and specifies if you want to change the

position of all subtitles (default), or only the currently selected one. This is also the menu

where you will find settings related to the DVD overlay, and the creation of palette files

with *.sup files.

• All the synchronization options: time shifting, frame rate conversion, and, the most

useful option, based on an original SUP or VobSub subtitle file. Additionally, it allows



you to specify if you want to display every line when synchronizing with another SUP

(see Synchronize) or every second, fifth or tenth line.

• The Tools menu allows you to manipulate existing SUP or VobSub subtitles, so you can

reposition them or remap the colors. Additionally, you can automatically shift original

subtitles to the current subtitle text area, and finally, it contains a DVD authoring wizard

that allows you to easily create a simple DVD with your new subtitle (but without

menus).

Other options:

1. DVD player options (you should only see this if you have DirectX installed, and have a

software DVD player, i.e. the MPEG codec, on your system):

Open DVD, root menu, chapter menu, stop, play backwards, pause, play, previous and

next chapter, plus a tracker that let’s you jump through the movie.

Currently, this feature doesn’t work if another program already uses the DVD interface,

such as DVDshrink.

2. Choose the subtitle colors here, and their transparency. The colors are defined in the IFO

that comes with the DVD (SubtitleCreator starts with the IFO in the Examples directory).

As the original subtitles also use this color palette, you better use it yourself. However

you can also open an external palette file if needed (*.ifo, *.mxp or *.clb formats are

supported) using the File � Open Palette menu. You can even copy paste palettes

between SubtitleCreator and PgcEdit.

3. Position the subtitle window (I play the DVD and reposition the subtitle window using

the two black triangle markers, which indicate the top and bottom of the window).

Additionally, after loading a DVD, you should see a third menu (see above) that allows

you to synchronize with the DVD (I prefer the advanced synchronization using an

original SUP or VobSub, but sometimes the movie doesn’t have a subtitle, in which case

I resort to this option). It works as follows: you pause the movie, select the subtitle you

would like to appear at the current time, press “Insert sub”, and potentially adjust the

timing a little. After you have done this for a couple of subtitles (at least one near the

beginning, and one near the end), press synchronize and voilà, all other subtitles are

corrected as well using time shifting and frame rate corrections.

4. Stretch the subtitles if needed. This is needed if you use an anamorphic DVD. In this

case, choose a value between 1.2 and 1.33 for the Y stretch. Watch the DVD with the

subtitle overlaid to check the final aspect of your subtitles.

5. A set of options to control the appearance of the subtitles:

First line: Save subtitle (CTRL-T), Split subtitle at line break, Remove line break,

Delete subtitle, Search subtitles (CTRL-F is new search, or F3 to repeat the search)

Second line: Bold (CTRL-B), Italics (CTRL-I), Underline (CTRL-U), Jump to a selected

subtitle (CTRL-J), and AB repeat.

Insert shortcuts: insert predefined (in SubtitleCreatorProfiles.xml) text, such

as Music symbols (<s M/> and <s m/>), at the beginning of the string. Some other useful

commands are <L>, <l> and <s> to make the current line Larger, larger, or smaller than

the current subtitle font.



List box: You can edit the times and the subtitle text (double click), and select whether

or not you wish to include it. Uncheck subtitles if you wish to exclude them for some

reason. Note that you can use italics (start with <i> and optionally end with </i>), bold

(<b> versus </b>), regular and underline (<u> versus </u>) fonts.

Tip: If you want to use another font for the current subtitle, you can specify it as follows:

<f Name='Arial Narrow', Type='Regular', Size='14'>.

Tip: If you wish to position the current subtitle somewhere else, you can go to Settings,

unselect “Change all subtitles”, and move the subtitle box with the mouse.



Advanced Synchronization Window

One of the biggest problems I had was synchronizing the subtitles of a movie with the video

and audio. Therefore, I created this feature which uses one of the original subtitles of the

DVD to synchronize your own subtitles.

The interface is very intuitive to me, and I hope to you as well: just select corresponding

subtitles left (1 – from the original SUP or VobSub file) and right (2 – your subtitle file)

windows, and click “Add Link” (3). The created links are shown in (4) and can be deleted

with (5). Finally, select “Synchronize” (6) when you are done, which will use linear

synchronization to correct for time shifts and frame rate conversions between the different

subtitles.

Tip 1: By double clicking in the left (1) window, the right window (2) will jump to a subtitle

that has approximately the same start time. The same for double clicking in the right

window, although less practical as there are fewer subtitles to show in the left.

Tip 2: When your subtitles are split in two parts, you are never sure whether the second part

continues straight away after the first set of subtitles, or whether there is an additional pause.

Therefore, create links with the original for (one of) the first and last subtitle in each set. You

will see some additional buttons ‘<’ and ‘>’to jump to the beginning and end of each file,

respectively.

Tip 3: If you need more (or less) subtitles, you can set your preferences in the main

window’s Settings menu (“When synchronizing, display…”) or in the configuration file,
SubtitleCreatorProfiles.xml.



SUP or VobSub Subtitle Manipulation
Select Tools�Manipulate SUP or VobSub, and you will see the following window appear,

which allows you to change each subtitles’ vertical position, and you can use a different set

of colors. You can also open HD-DVD subtitles demuxed using EvoDemux. The HD-DVD

subtitles will be converted to DVD subtitles on the fly before being open. Note that you can’t

open Blu-Ray subtitles with SubtitleCreator.

About the buttons:

1. The Open IFO button allows you to open the subtitles’palette file (*.ifo, *.mxp or *.clb).

2. The Open sub. button to open the SUP or VobSub file you want to manipulate.

3. The Save sub. button to save the subtitles as a SUP or VobSub file.

4. The Save BMP button to save the subtitles as a collection of .bmp, .png or .jpg files.

5. The Delay button allows to add a Delay to the whole subtitle.

The other options should be clear:

1. Remap the colors of all subtitles, or only this subtitle.

2. Force the palette to the default subtitle color palette. (This setting will be automatically

deselected when you open a palette file or an idx file).

3. Choose if you want to apply the vertical offset to all the subs or only to the current one.

4. Select a subtitle you wish to display

5. Move the subtitle vertically (use the vertical track bar).



Importing HD-SUP files

Starting with version 2.2, SubtitleCreator can import High Definition subtitles (HD-DVD

format). Blu-Ray subtitles are not supported yet.

To import such a subtitle (for example extracted from a HD-DVD using EvoDemux), just

open it like a standard SUP file (Tools=> Manipulate SUP or VobSub menu) and

SubtitleCreator will detect that it’s a HD subtitle and automatically convert it to the SD

format. Depending on the state of the “Manipulate SUP or VobSub” window (PAL or

NTSC), the HD subtitle will be converted into a NTSC or PAL subtitle. The size of the

subtitle is converted from the HD resolution (1920x1080) to the SD resolution (720x576 for

PAL, 720x480 for NTSC), the number of colors is reduced to 4 and the corresponding

palette is generated (Only the colors of the first HD-SUP subtitle are used to generate the

palette). You can then save the resulting SD subtitle to the SUP or VobSub format. However

remember that the saved subtitle will have less colors and a smaller definition than the

original HD-SUP file so you’d better save also the original for future use.



DVD Authoring Wizard
After you have installed PgcDemux, Muxman and VobBlanker (latest versions, see the

Installation chapter), you can use the DVD authoring wizard for your convenience, which

has two big advantages: First, you don’t need to interface with these programs directly. And

second, the subtitle creation can be done at the start of the process, and not in the middle.

The wizard will ask you to:

1. Select the original DVD’s location:

2. Press Next: PgcDemux will automatically extract existing (or remaining) subtitles for

synchronization (optionally you can turn this of, and you can define alternative output

locations for temporary and final files)

3. Specify the new subtitle’s language and open the file, after which you have to go through

the normal process in order to create a SUP file (position it, check subtitle colors, font

size, etc.)

4. Finally, create the SUP and return to the wizard to allow PgcDemux to demultiplex your

DVD into separate video, audio and subtitle streams, MuxMan to put everything back

together again (including your new subtitle), and VobBlanker to restore the menu.



When there is no existing subtitle stream in the original DVD (home made DVD for

example) the Wizard will automatically select the prefered palette. This should avoid

black/green subtitles.



Subtitle on top of DVD Preview

With SubtitleCreator, it is possible to preview the actual subtitles on top of the video. This

works with every type of subtitles, whether they be horizontal, vertical, in Chinese, Japanese,

or any other language.

To be able to preview the subtitles on top of the DVD, SCSubtitle filter must be installed.

Normally it has been installed automatically when installing SubtitleCreator 2.2. A DVD

decoder must also be installed to allow you to preview your DVD. We recommend the use of

PowerDVD 6 (Version 4 and 6 have been tested successfully).

If PowerDVD and SCSubtitle filter are correctly installed, you can now preview your

subtitles on top of your DVD.

For that:

1. Go to Settings, Select DVD Decoder and choose “Preferred by SC” if you have

PowerDVD version 6 installed or “Preferred by system” if you want the system choose it

for you.

2. Go to Settings and check “Overlay subtitles on DVD (experimental)” if it’s not already

done. You can choose “Save settings” if you want to save it for the next time.



3. Open your subtitle file (.srt or .sub). (File�Open Text Subtitles). Optionally you can

apply a profile (Profiles�Apply profile)

4. Choose the path and open your DVD (from a DVD or the Hard Disk)

5. Start playing your DVD

You must see the time incrementing on the title bar of the DVD window. The subtitles must

be overlaid on top of the video.

If you right click on the DVD window, a popup will allow you to control your DVD: stop,

pause, and single-step, display the video Full Screen, go to the next or previous chapter,

display a subtitle stream (from the DVD) and change the audio stream. This means that you

can display subtitles from the DVD and from you subtitle file at the same time!

You can also choose the about box that will display useful information about the DVD. It

also displays the version of SC Subtitle filter and the DVD decoder that SubtitleCreator is



actually using. If it shows “Preferred DVD video Decoder” as the DVD decoder this means

that you should have no problem to overlay subtitles on top of the DVD.

Known restrictions:

• The DirectShow filter that is used to overlay the subtitles on top of the DVD (SC Subtitle

filter) will not work with all the DVD video decoders. We advice that you use

PowerDVD (version 6 is the preferred version).

• Your PC must be powerful enough. According to the first tests, a 1.5GHz processor

should be enough (to be confirmed). This also depends on the size of the subtitles you

are using. The larger the subtitle, the more CPU power is needed.

• The aspect of the subtitles when in overlay mode reflects the aspect of the subtitle after

being embedded in the final DVD. However, the timing is not very accurate. A 1-2

second shift is possible. We plan to fix this in the next versions.



Additional functionalities

The following functions have been added recently to SubtitleCreator. They are still beta

functions so please be comprehensive if they don’t really work as they should.

Tools� Recognize text using OCR

This function will work only if Microsoft Office 2003 is installed. It will used the OCR that

comes with Office 2003 to automatically transform a SUP or VobSub file to the srt format.

Tools � Translate SUP or VobSub to SRT

This will allow you to translate a SUP or VobSub file to SRT by hand. You can either type

the original’s subtitle text or directly a translation. This function will automatically add the

timing information of the original file for you.

Tools � Google Translate

This uses Google Translate to automatically translate for you a srt file from a language to

another. This means that you need an open internet connection if you want to use this

functionality. However it seems this option is not really working because of Google not

allowing for multiple requests by an external software.

Tools � Conceal hard-coded subtitles

This allows you to add empty subtitles with a solid background to mask hard-coded subtitles.

Note that after a manual chapter switch, you have to wait till the first subtitle arrives before it

becomes effective (subtitles have no stop time, but need to start).



VobSub format specificities

WARNING: VobSub file support is still in beta tests so please backup all your existing

VobSub files before using them.

Differences between SUP and VobSub binary subtitle formats

Starting with version 2.1, SubtitleCreator supports VobSub format. This format is very

similar to the SUP format also (and originally) supported by SubtitleCreator. The Sup and

VobSub formats are “binary” formats where each subpic is stored as a picture. The Sup

format is especially useful to add subtitle streams to an existing DVD. The VobSub format is

used for subtitle that are overlaid on top of existing DVDs or AVI files using either SAP

(Stand Alone Players) or software video player (Media Player Classic, VLC or KMPlayer

are good examples of player supporting the overlay of VobSub subtitles).

A VobSub subtitle stream is composed of two files which share the same name and have the

“.idx” and “.sub” extensions. The “.sub” file is a binary file holding the bitmaps, the timings

information (start time and duration of each subpic) and the stream IDs. The “.idx” format is

a text file holding, palette information, language information and also the timing information

(only the start time of each subpic). A VobSub filepair can also hold several subtitle streams.

SubtitleCreator VobSub support (INPUT)

SubtitleCreator supports multi-stream VobSub files. When you open such a file (Tools �

Manipulate SUP or VobSub), SubtitleCreator will ask you which Subtitle stream you want

to open (you can only open one substream at a time).

You can then process it the same way as if it was a SUP file.



When you open a VobSub file, SubtitleCreator uses the language and timing information it

finds in the idx file (the duration comes from the sub file). It will also automatically switch

the interface to NTSC or PAL mode according to what’s specified in the *.idx file. There is a

very easy method to delete some unneeded subtitles from a VobSub file. Just delete the

corresponding lines from the idx file and the corresponding subtitles will be deleted.

SubtitleCreator will also use the color palette of the idx file. SubtitleCreator supports also the

VobSub “delay: [sign]hh:mm:ss:ms” tag. SubtitleCreator will update its internal palette

with the palette found in the idx file. BE CAREFUL: This palette (until it is overwritten

reading an IFO file, another idx file or applying the default subtitle colors) will be the one

used for further subtitle generations.

SubtitleCreator VobSub support (OUTPUT)

SubtitleCreator allows you to create VobSub files. You can create a VobSub file directly

form a srt of sub (text) file. Just use Files � Save VobSub or Save VobSub as...

SubtitleCreator will ask you for the language of the stream. You can also create VobSub files

using SUP or VobSub file. Use the Tools � Manipulate SUP or VobSub menu to open the

file you want to save in the VobSub format. Make all the needed changes and Click on Save

sub. On the drop-down list, choose “VobSub files (*.idx)” and type the name of the output

file.

If the file you have open is already a VobSub file with a language id, your stream will be

saved with the same language id as the input file. If the input file was a SUP file, then

SubtitleCreator will ask you for the language of the stream.

SubtitleCreator allows you to add your VobSub stream at the end of an existing VobSub file.

This allows you to add extra languages to existing VobSub files and have the choice of the



language on your Stand-Alone player even if your player accepts only one subtitle file. To

our knowledge this is a unique feature.

To add a stream at the end of an existing VobSub file just use the name of the VobSub file

you want to add the stream to as the output file name. SubtitleCreator will first ask you if

you want to overwrite it. Just answer OK. Then it will ask you if you want to append your

stream at the end of the existing VobSub file. Answer OK again. This works with the Files

� Save VobSub or Save VobSub as... menus and also with the Tools � Manipulate SUP

or VobSub menu.

Alternatively, you can use the Command Line Interface (see corresponding chapter).



Command Line Interface (CLI)

Most of SubtitleCreator’s functions can be accessed using the Command Line Interface. This

allows power-users to use SubtitleCreator in their custom scripts. In order to know the

available options, open a Command prompt and type SubtitleCreator –h. You will get the

following screen that sums up the available options:

When an option is inside [], it means it is not mandatory.

Creating a SUP file:

• From a .srt or .sub (text) file:

SubtitleCreator test.srt [-p1] [-iVTS_01_0.IFO]

-p1 means use the first profile

-iVTS_01_0.IFO means use VTS_01_0.IFO to get the palette of the original DVD (This

option is very important if you want your subtitles to be in the correct colors).

• From a VobSub file:

SubtitleCreator test.idx [-x2]

-x2 means that the stream with index 2 of the VobSub file will be extracted. The name of

the output file will be constructed using the name of the idx file + “_”+language



string+“_0x” +HEX(the stream number +32). In the example’s case, it will be

test_en_0x20.sup. No -x option means use the first stream found.

Creating a VobSub file:

• From a .srt or .sub (text) file:

SubtitleCreator test.srt -ven [-p1] [-iVTS_01_0.IFO] [-

aMySub.idx]

-ven means that the output format is VobSub and that the language code for this stream is

English (en) (use -vfr, for French, ...). This option is mandatory because without it, the

output format is SUP.

-p1 means use the first profile

-iVTS_01_0.IFO means use VTS_01_0.IFO to get the palette of the original DVD (This

option is very important if you want your subtitles to be in the correct colors).

-aMySub.idx means that the generated stream must be appended to the filename given

here. If the file doesn’t already exist, it will be created. This option can be use to add

some additional language streams to VobSub files. This option is only valid for VobSub

files.

• From a SUP file:

SubtitleCreator test.sup [-ven] [-aMySub.idx]

-ven means the language code for this stream is English (en) (use -vfr, for French, ...). If

it is not present, english will be used by default (en).

-aMySub.idx means that the generated stream must be appended to the filename given

here. If the filename doesn’t already exist, it will be created. This option can be use to

add some additional language streams to VobSub files. This option is only valid for

VobSub files.



FAQ

• Where are SubtitleCreator’s settings stored?

C:\Documents and Settings\User Name\Local Settings\Application Data\SubtitleCreator\Settings.xml

• Where are SubtitleCreator’s profiles stored?

C:\Documents and Settings\User Name\Local Settings\Application Data\SubtitleCreator\ Profiles.xml

• When I create a VobSub subtitle (*.sub/*.idx), and use it with a software player they look fine but on my

SAP (Stand Alone Player) they are shifting during playback.

This is a known bug that will be fixed some day. In the meantime you can use the following fix (found and

described by FitzGerald here:

 http://forum.doom9.org/showthread.php?p=1007483#post1007483 ):

“...You have to make 2 sets of .idx+.sub files. One set is just the original timings. For the second set, convert

the file from 29.97 to 30 fps. Take the original timings .idx and match it up with the .sub file from the "hacked"

set to create a set that works on my SAP”.

• I can’t start SubtitleCreator, I always get an exception at startup. What can I do?

It may be due to the fact that SubtitleCreator tries to open the last sub that you have open and that it has an

error that causes an exception. To check if it is the case, find the file named C:\Documents and Settings\User

Name\Local Settings\Application Data\SubtitleCreator\MRU.txt and rename it to something else like

MRUold.txt.

Try to open SubtitleCreator. If it is working, quit it, rename your file MRU.txt again and suppress its first line

that points to a bad file.


